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Regulatory Compliance

The CY15FRAMKIT-001 Serial F-RAM™ Development Kit is intended for use as a serial memory development platform
for hardware or software in a laboratory environment. The board is an open-system design, which does not include a
shielded enclosure. Therefore, the board may cause interference with other electrical or electronic devices in close
proximity.

Attaching additional wiring to this product or modifying the product operation from the factory default may affect its
performance and cause interference with other apparatus in the immediate vicinity. If such interference is detected, suitable
mitigating measures should be taken.

The CY15FRAMKIT-001, as shipped from the factory, has been verified to meet with the requirements of CE as a Class A
product.

The CY15FRAMKIT-001 contains ESD-sensitive devices. Electrostatic charges readily accumulate

on the human body and any equipment, and can discharge without detection. Permanent damage
may occur to devices subjected to high-energy discharges. Proper ESD precautions are
recommended to avoid performance degradation or loss of functionality. Store unused

‘Q \ CY15FRAMKIT-001 boards in the protective shipping package.

End-of-Life/Product Recycling

The end-of-life cycle for this kit is five years from the date of manufacture mentioned on the back of
the box. Contact your nearest recycler to discard the kit.
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General Safety Instructions

ESD Protection

ESD can damage boards and associated components. Cypress recommends that the user perform procedures only at an
ESD workstation. If an ESD workstation is not available, use appropriate ESD protection by wearing an antistatic wrist
strap attached to the chassis ground (any unpainted metal surface) on the board when handling parts.

Handling Boards

CY15FRAMKIT-001 boards are sensitive to ESD. Hold the board only by its edges. After removing the board from its box,
place it on a grounded, static-free surface. Use a conductive foam pad if available. Do not slide the board over any surface.
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Thanks for your interest in the CY15FRAMKIT-001 Serial F-RAM Development Kit (DVK). The kit (shield) is designed as
an easy-to-use and inexpensive development kit, showcasing the features of Cypress serial ferroelectric random access
memory (F-RAM). Designed for flexibility, this kit offers footprint-compatibility with CY8CKIT-042 PSoC® 4 Pioneer Kit,
CY8CKIT-040, CY8CKIT-042 BLE, third-party Arduino™ UNO R3, and several other Arduino kits. This board features a
256-Kbit SPI F-RAM, a 256-Kbit I2C F-RAM, three-pole DIP switch to control the I°C F-RAM device select pins, Arduino
UNO compatible headers, and two debug headers. This kit supports power supply voltages of either 5.0 V or 3.3 V.

The CY15FRAMKIT-001 is a development kit for the Cypress Serial F-RAM memories. Cypress F-RAM is built on
ferroelectric technology, which combines the nonvolatile data storage with the high-performance RAM. Serial F-RAMs
provide fast writes at full bus speed. They do not have any write delays and data is instantly nonvolatile. They consume as
low as 300 pA active and 6 YA standby current. Because of fast write speeds, serial F-RAMs need to be active for short
periods, yielding very low energy consumption. Endurance is virtually unlimited offering 100 trillion read/write cycles.

1.1 Kit Contents

The CY15FRAMKIT-001 Serial F-RAM DVK includes the following contents, as shown in Figure 1-1:
®  CY15FRAMKIT-001 serial F-RAM DVK board
B Quick start guide

Figure 1-1. CY15FRAMKIT-001 Serial F-RAM DVK Contents

| "\Mm
007 SERIAL f. RAMM e
LOPMENT e

Visit www.cypress.com/shop for more information. Inspect the contents of the kit; if any parts are missing, contact your
nearest Cypress sales office for help.
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1.2 PSoC Creator™

PSoC Creator is a state-of-the-art, easy-to-use integrated design environment (IDE). It introduces revolutionary hardware
and software codesign, powered by a library of preverified and precharacterized PSoC Components™.

With PSoC Creator, you can:

®  Drag and drop PSoC Components to build a schematic of your custom design
®  Automatically place and route components and configure GPIOs

®  Develop and debug firmware using the included component APls

PSoC Creator also enables you to tap into an entire tools ecosystem with integrated compiler chains and production
programmers for PSoC devices. For more information, visit www.cypress.com/Creator.

1.3 Getting Started

This guide helps you to get acquainted with the Serial F-RAM DVK. The Kit Installation chapter describes the installation
of the kit software. The Kit Overview chapter explains the features of the kit. The Hardware chapter details the hardware
operation. The Examples Projects chapter describes the code examples. The Appendix provides the schematics, pin
assignment, use of zero-ohm and 30-ohm resistors, and the bill of materials (BOM).

1.4 Additional Learning Resources

Visit www.cypress.com/go/F-RAM for additional learning resources in the form of datasheets and application notes. The
baseboard-related resources are available in the following links.

m  CY8CKIT-042 PSoC 4 Pioneer Kit
B Arduino UNO R3

1.5 Technical Support

For assistance, go to our support web page, www.cypress.com/support, or contact our customer support at
+1 (800) 541-4736 Ext. 2 (in the USA) or +1 (408) 943-2600 Ext. 2 (International).

1.6 Documentation Conventions

Table 1-1. Document Conventions for Guides

Convention Usage
Courier New Displays file locations, user-entered text, and source code:
C:\...cd\icc\
Italics Displays file names and reference documentation:
Read about the sourcefile.hex file in the PSoC Designer User Guide.
[Bracketed, Bold] Displays keyboard commands in procedures:
[Enter] or [Ctrl] [C]
File > Open Represents menu paths:
File > Open > New Project
Bold Displays commands, menu paths, and icon names in procedures:
Click the File icon and then click Open.
Times New Roman Displays an equation:
2+2=4
Text in gray boxes Describes cautions or unique functionality of the product.
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This section describes the installation of the CY15FRAMKIT-001 Serial F-RAM DVK software and prerequisites.

2.1 Prerequisite Software

You must install the PSoC Creator IDE or the Arduino IDE before using the kit. All Cypress software installations require
administrator privileges. Administrator privileges are not required to execute the software after installation. Close all other
Cypress software that is currently running before you install the kit software.

To download the PSoC Creator IDE, go to www.cypress.com/psoccreator.

To download the Arduino IDE, go to arduino.cc/en/Main/Software.

2.2 Install Kit Software

Follow these steps to install the CY15FRAMKIT-001 Serial F-RAM DVK software:

1. Download the CY15FRAMKIT-001 DVK software from www.cypress.com/go/CY15FRAMKIT-001. The
CY15FRAMKIT-001 software is available in three different formats (see Figure 2-1):

Figure 2-1. Available Formats for Downloading Serial F-RAM DVK Software

(@) | O cY15FRAMKIT-001 Kit Setup (Kit Design Files, Documentation, English
Examples) B
(b) | 2 cv1sFramKIT-001 cDIsO B English

e CYI15FRAMKIT-001 Kit Setup: This executable file installs only the kit contents, which include kit code
examples, hardware files, and user documents.

e CY15FRAMKIT-001 CD ISO: This file is a complete package, stored in a CD-ROM image format, which you can
use to create a CD or extract using ISO extraction programs, such as WinZip or WinRAR. The file can also be
mounted like a virtual CD using virtual drive programs such as Virtual CloneDrive and MagiclSO. This file
includes all the required firmware, hardware files, and user documents.

2. If you have downloaded the CD ISO file, mount it on a virtual drive. Extract the ISO contents if you do not have a virtual
drive on which to mount. Double-click cyautorun.exe in the root directory of the extracted content or mounted ISO if
“Autorun from CD/DVD” is not enabled on the PC. The installation window shown in Figure 2-2 will appear
automatically.

Note: If you are using the Kit Setup file, then go to step 3 for installation.

3. The kit startup screen appears as shown in Figure 2-2. The default installation location is Cypress under Program
Files folder.
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Figure 2-2. Kit Installer Startup Screen

CY15FRAMEIT-001 Serial F-RAM Kit - InstallShield Wizard

Welcome to the InstallShield Wizard for
CY15FRAMKIT-001 Serial F-RAM Kit

The InstallS hield *Wizard will install Cv1SFRARMEIT-001
Serial F-Rak Eit on pour computer. To continue, click
Mesxt.

Select folder where setup will inztall files.

=

Install CY15FRAMEIT-007 Serial
C:h ACypress

< Back [

J |

Mext = Cancel

Kit Installation

Select the folder in which you want to install the CY15FRAMKIT-001 kit-related files. Choose the directory and click

Next.

Next.

Figure 2-3. Product Installation Overview Window

< Cylnstaller for CY15FRAMKIT-001 Serial F-RAM Kit

Product Installation Overview

Choose the install type that best suits your needs

(2 )

Choose the type of installation

Product:
CY15FRAMKIT-001 Serial F-RAM Kit

Installation Type:

Typical v

Installs the most common features of
CY15FRAMKIT-001 Serial F-RAM Kit.

[ Next> || Cancel

)

Select the Typical installation type in the Product Installation Overview window, as shown in Figure 2-3. Click

When the installation begins, a list of packages appears on the installation page. A green check mark appears next to

each package after successful installation.

CY15FRAMKIT-001 Serial F-RAM Development Kit Guide, Doc. No. 001-95689 Rev. *C
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5.

If this is the first Cypress product that you have installed, enter your contact information or select the option Continue
without Contact Information. Click Finish to complete the CY15FRAMKIT-001 kit installation.

After the installation is complete, the kit contents are available at <Install Directory>\CY15FRAMKIT-001
Serial F-RAM Kit\1.0. The default locations are as follows:

Windows 7 (64-bit): C:\Program Files (x86)\Cypress\CY15FRAMKIT-001 Serial F-RAM Kit\1.0
Windows 7 (32-bit): C:\Program Files\Cypress\CY15FRAMKIT-001 Serial F-RAM Kit\1.0

Note: For Windows 7/8/8.1 users, the installed files and the folder are read-only. To change the property, right-click
the folder and choose Properties > Attributes and then disable the Read-only option. Click Apply and OK to close
the window.

After the installation is complete, the following are installed on your computer:

Kit documents

e  Quick start guide

e Kitguide

e Release note

Firmware

e PSoC 4 F-RAM SPI example project

e PSoC 4 F-RAM I12C example project

e  Arduino UNO F-RAM SPI example project
e Arduino UNO F-RAM I2C example project
Hardware

e  Schematic

e Layout

e Gerber

e PCB assembly drawing

e  Bill of materials (BOM)

2.3 Uninstall Software

The software can be uninstalled using one of the following methods:

Go to Start > Control Panel > Programs and Features; select the appropriate software package and click
Uninstall.

Go to Start > All Programs > Cypress > Cypress Update Manager > Cypress Update Manager.

e Select the “CY15FRAMKIT-001 Serial F-RAM Kit 1.0 Rev **” row and click Uninstall. In the Product
Installation Overview window, select Remove from the Installation Type drop-down menu. Follow the
instructions to uninstall.

Note: This method will uninstall only the kit software and not all the other software that may have been installed
along with the kit software.
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3.1 CY15FRAMKIT-001 Serial F-RAM Development Kit Overview

The CY15FRAMKIT-001 Serial F-RAM DVK can be used to understand the features of the serial F-RAMs (SPI and I2C).
The DVK is a shield board, which contains the 256-Kbit SPI F-RAM and 256-Kbit I°C F-RAM. It has four connectors that
are Arduino UNO-compatible and connect to either Cypress PSoC 4 Pioneer Kit or Arduino UNO R3 board. These
connectors are stackable and hence any other Arduino-compatible shields can be stacked on it. The kit has options to
operate at either 3.3 V or 5.0 V. Figure 3-1 shows the DVK board and its general description.

Figure 3-1. General Description of DVK Board

Arduino Arduino
Compatible I/O Compatible 1/0
Header (J3) Header (J4)

_ L}
SPI F-RAM | e slBEg 22 22eR ﬁ:‘l 12C E-RAM
FM25W256 (U1) “ '&u i L FM24W256 (U2)

;I 1 J7
Debug Header
)

Debug/Arduino
Compatible ICSP
1/0 Header (J6)

CY15FRAMKIT-001

Power LED F%R ;_g’ T3 I12C Slave
(LED1) gzox_ﬂ‘lsi;z __cyVob Address
Selection

(SW1)

Power Select
Jumper (J5)

Arduino Arduino
Compatible 1/0 Compatible I/O
Header (J1) Header (J2)

Refer to section A.5 Use of 30-ohm Resistors and No Load to modify the CY15FRAMKIT-001 hardware by mounting two
30-Q resistors to make it Arduino UNO R2-compatible.
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3.2 Kit Operation and Configuration Guide

3.2.1 Power Supply Jumper

CY15FRAMKIT-001 can operate at either 3.3 V or 5.0 V, selected through jumper J5, as shown in Figure 3-2. The factory
default jumper setting is 5.0 V (short pins 1 and 2). Arduino UNO R3 boards operate at 5.0 V and use the default setting of
the jumper J5. The CYBCKIT-042 Pioneer Kit operates at either 3.3 V or 5.0 V. The default setting of the Pioneer Kit is 3.3
V. Therefore, depending on the voltage setting on the mother board, set jumper J5 to either 5.0 V (short pins 1 and 2) or
3.3 V (short pins 2 and 3).

1. Do not power the CY15FRAMKIT-001 board through an external power source. The
board is designed to be powered by the mother board.

2. The CY15FRAMKIT-001 operates from 2.7 V to 5.5 V. Exceeding the maximum
CAUTION o
voltage limit (5.5 V) can damage the board.

3. For proper operation of the board, ensure that jumper J5 is set to match the
operating voltage on the motherboard.

Figure 3-2. Power Select Jumper

Power Select
Jumper (J5)

3.2.2 F-RAM Devices

256-Kbit SPI

256-Kbit 12C
F-RAM (U1)

F-RAM (U2)

CY15FRAMKIT-001

3.2.3 DIP Switch for I°C F-RAM Device Slave Address Select

The DVK provides a DIP switch option, as shown in Figure 3-4, to configure the different slave address for the I2C F-RAM
by assigning its individual slave select address pins (A2-A0) either to logic LOW ‘0’ or logic HIGH ‘1°. When the DIP switch
is in the ON position, it keeps the respective slave select address pin to logic HIGH using a 4.7 kQ pull-up resistor. When
the DIP switch is not in the ON position, the respective slave select address pins are kept at logic LOW by F-RAM device
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through an internal weak pull-down resistor. The factory default setting for the DIP switch is not in the ON position which

sets the values for A2, Al, and AO to logic LOW ‘0’.

Figure 3-4. DIP Switch for I°C F-RAM A0, A1, and A2 Configuration

DIP Switch (SW1)

Deviice Select Addr
U2

s
[l
[}
[_1:.:
-3 @
Pe

rG‘

3.2.4 Connectors to CY8CKIT-042/Arduino UNO R3 Board

Figure 3-5 shows the Arduino-compatible connectors to the CY8CKIT-042/Arduino UNO R3 boards: J1, J2, J3, and J4.
You can plug the DVK board into the CY8CKIT-042/Arduino UNO R3 board through these connectors. For schematic

details, refer to the Hardware chapter on page 17.

Figure 3-5. Connectors to CY8CKIT-042/Arduino UNO R3 Board

Arduino

Compatible 110
Header (J3)

FoRM
CY15FRAMKIT-001

#POWER LED
o ey O
LED1 R cyVOD

N+
J5
w |3
&e m@®l
® sy Y3y o
=
R1

Arduino
Compatible I/O
Header (J4)

;ﬁ ;ggscniTSI

RESET |6ND

O A0 AL A2

zZ O QU Vv Y
O Zzy

Arduino

Compatible /O Compatible 1/O
Header (J1) Header (J2)
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3.2.5 Debug Headers
Debug headers are provided for easy access to the SPI and 12C communication pins. As shown in Figure 3-6, jumper J6

follows the in-circuit serial programming (ICSP) header pin layout and provides access to the SPI signals. Jumper J7
provides access to the chip select of the SPI F-RAM device and 12C communication signals.

Figure 3-6. Debug Headers

1

e U 9 O
s X £ =

ARy gl
‘ Hnu Il

)
Debug
Header (J7)

Debug / Arduino
Compatible ICSP I/O
Header (J6)

3.2.6 Test Points

The DVK board provides Voo (TP3) and GND (TP1 and TP2) test points as shown in Figure 3-7.
Figure 3-7. Test Points

TP1 TP?

TP3 VDD

GND GND

These test point are only for probing and measurement purposes. Do not power the kit

celie using these test points to avoid any damage to the board.

3.3 CY15FRAMKIT-001 with PSoC 4 Pioneer Kit

The CY15FRAMKIT-001 is plugged into the PSoC 4 Pioneer Kit (CY8CKIT-042) through four connectors: J1, J2, J3, and
J4. The default operating voltage of serial F-RAM kit is 5.0 V. To match this, change the voltage setting on the PSoC 4
pioneer kit to 5.0 V. You can also operate at 3.3 V by selecting the 3.3 V power settings on both PSoC 4 pioneer and
serial F-RAM Kits.

Note: J2 on the CY15FRAMKIT-001 is a 6-pin, single row jumper. On the PSoC 4 Pioneer Kit, J2 is a 9x2 header. Therefore,
J2 of the CY15FRAMKIT-001 plugs into the six pins on the extreme left of the outer row of the J2 header on the Pioneer
board. This can be easily observed because the CY15FRAMKIT-001 can be inserted only in one direction.
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Figure 3-8. CY15FRAMKIT-001 Mounted on PSoC 4 Pioneer Kit

3.4 CY15FRAMKIT-001 with Arduino UNO R3 Kit

The CY15FRAMKIT-001 is plugged into the Arduino UNO R3 Kit through four connectors: J1, J2, J3, and J4. These
connector pins are mapped one to one.

Figure 3-9. CY15FRAMKIT-001 Mounted on Arduino UNO R3 Kit
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4.1 Board Detalls

The CY15FRAMKIT-001 Serial F-RAM DVK consists of the following blocks as shown in Figure 4-1.
m  256-Kbit SPI F-RAM (U1)

m  256-Kbit I2C F-RAM (U2)

B Power select jumper (J5)

®  Power LED (LED1)

®  DIP switch for device address selection (SW1)

®  Debug headers for SPI/12C signals (J6, J7)

B Arduino-compatible connectors (J1, J2, J3, J4)

Figure 4-1. CY15FRAMKIT-001 Serial F-RAM DVK Details

Arduino Arduino
Compatible I/O Compatible I/O
Header (J3) Header (J4)

SPI F-RAM
FM25W256 (U1)

I2C F-RAM
FM24W256 (U2)

Debug Header
7

Debug / Arduino

Switch (SW1)

s }'?.250%! ]-‘*I ®e Compatible ICSP
o Restf(oho @ @) I/O Header (J6)
123 £y P> ol e [l s se
g8 || f
Power LED #POWER LED gt | 1‘“
(LED1) R e “’3@ ‘ I2C Device
gzolfvs'}z _cyVoD | Select Address
|

o0 8
J5 |
Power Select s [ |

Jumper (J5) W ma O A0 A1 AZ
(] ‘5v

=¥
R1

Figure 4-2. CY15FRAMK Arduino | DVK F Arduino > 4 Pioneer/Arduino UNO R3 Kit
Compatible 1/ Compatible 1/0
- Arduino UNQ4eader (J1) PSoC 4 Pigyegadi{J2)
) . . P4_0/A5
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4.2 Theory of Operation
This section provides the block-level description of the PSoC 4 Pioneer Kit.
Figure 4-3. Block Diagram
Arduino Compatible Headers (J1-J4)
A A
3.3V and 5V
Power Selection Jumper
SPI (J5) 12C
e
(LED1) 3.3V or 5V
L * Debug * T DIP Switch
Header for (SW1) for
SPIFRAM e > SP2C  |e——n  2CFRAM e | Device Address
(u1) : u2) :
signals Selection (A0,
(J6, JT) A1, A2)

The CY15FRAMKIT-001 Serial F-RAM DVK provides 256-Kbit SPI and 256-Kbit I°C F-RAM devices. The DVK is a shield
board, which can be plugged into the PSoC 4 Pioneer Kit or the Arduino UNO R3 Kit.

The CY15FRAMKIT-001 Serial F-RAM DVK has a power LED (LED1) indicating the power-ON condition. The kit can
operate either at 3.3 V or 5 V selected through jumper J5. The kit also has the option to change the device address for the

I2C F-RAM. The kit also provides debug headers for SPI / I2C signals.

4.3 Functional Description

4.3.1 SPI F-RAM Device (256-Kbit FM25W256)

The CY15FRAMKIT-001 Serial F-RAM DVK uses Cypress 256-Kbit SPI F-RAM device. The device pins are accessible for

reads and writes through Arduino-compatible headers.

Features

m  256-Kbit ferroelectric random access memory (F-RAM) logically organized as 32K x 8

e High-endurance 100 trillion (10'*) read/writes
e 151-year data retention
e NoDelay™ writes
e Advanced high-reliability ferroelectric process
®  Fast serial peripheral interface (SPI)
e Upto 20 MHz frequency
e Direct hardware replacement for serial flash and EEPROM
e  Supports SPI mode 0 (0,0) and mode 3 (1,1)

B Sophisticated write protection scheme

CY15FRAMKIT-001 Serial F-RAM Development Kit Guide, Doc. No. 001-95689 Rev. *C
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e Hardware protection using the Write Protect (WP) pin
e Software protection using Write Disable instruction
e Software block protection for 1/4, 1/2, or the entire array
B | ow power consumption
e 250 PA active current at 1 MHz
e 15 pA (typ) standby current
®  Wide voltage operation: VDD = 2.7 Vto 5.5V
B |ndustrial temperature: —40 °C to +85 °C
®  8-pin small outline integrated circuit (SOIC) package
®  Restriction of hazardous substances (RoHS) compliant
Memory Write

All writes to the SPI F-RAM begin with a WREN (Write Enable) opcode (0x06). The WRITE opcode (0x02) is followed by
a two-byte address containing the 15-bit address (A14-A0) of the first data byte to be written into the memory. The upper
bit of the two-byte address is ignored. The subsequent bytes after the two address bytes are data bytes, which are written

sequentially. Addresses are incremented internally as long as the bus master continues to issue clocks and keeps [
LOW. If the last address of 7FFFh is reached, the counter will roll over to 0000h. Data is written MSB first. The rising edge

of CS terminates a write operation. SPI F-RAM write operation is shown in the following figure.
Figure 4-4. SPI F-RAM Memory Write

o5\ /

o1 2 3 4 5 6 7

SCK
Sl \0O 0 0 0 O0/1 11\0

HI-Z

SO
Figure 4-5. SPI F-RAM Memory Write

cs \ [

2 3 4 5 6 70 2 3 4 5 6 7 12 13 14 15 0 2 3 4 5 6 7
SCK H
Opcode 15-bit Address Data
o Bho o 0 0 o of Lo/t |[fefoeledfloosalodenleabie)
HI-Z

SO

Memory Read

After the falling edge of CS, the bus master can issue a READ opcode (0x03). Following the READ command is a two-
byte address containing the 15-bit address (A14-A0) of the first byte of the read operation. The upper bit of the address is
ignored. After the read opcode and two address bytes are issued, the device drives out the read data byte on the next eight
clocks on SO pin. The Sl input is ignored during read data bytes. Subsequent bytes are data bytes, which are read out
sequentially. Addresses are incremented internally as long as the bus master continues to issue clocks and CS is LOW. If
the last address of 7FFFh is reached, the counter will roll over to 0000h. Data is read MSB first. The rising edge of CS
terminates a read operation and tristates the SO pin. SPI F-RAM read operation is shown in the following figure.
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Figure 4-6. SPI F-RAM Memory Read

cs [

12 3 4 5 6 7 01 2 3 45 6 7 121314150 1 2 3 4 5 6 7

soK Wlm

Opcode 15-bit Address

SI _\o 0000 O “@@@mﬂ@ @@ﬂ@
Data
HI-Z
SO D7 @@@@@@@

MSB LSB

Status Register Write

The write status register WRSR command (0x01) allows the SPI bus master to write into the status register of the SPI F-
RAM.

Figure 4-7. SPI F-RAM Status Register Write

cs | [
01 2 3 4 5 6 7 01 2 3 4 5 6 7

SCK

Opcode Data
SI _\0 000 0O0O @ﬂna@@aa
MSB LSB
SO HI-Z

Status Register Read

The read status register RDSR command (0x05) allows the bus master to verify the contents of the status register of the
SPI F-RAM. Reading the status register provides information about the current state of the write-protection features.
Following the RDSR opcode, the SPI F-RAM device will return one byte with the contents of the status register.

Figure 4-8. SPI F-RAM Status Register Read

s\ a
012 3 45 6 7 01 2 3 45 67

SCK |

Data

HI-Z
S0 o7)oeps) o403 ozfotpo)

MSB LSB

For more details on the F-RAM device, refer to the FM25W256 datasheet.
4.3.2 1°C F-RAM Device (256-Kbit FM24W256)

The CY15FRAMKIT-001 Serial F-RAM DVK uses the 256-Kbit 12C F-RAM device. The device is accessible for read and
writes through Arduino-compatible headers.
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Features
® 256-Kbit F-RAM is logically organized as 32K x 8
e High-endurance 100 trillion (1014) read/writes
e 151-year data retention
e NoDelay™ writes
e Advanced high-reliability ferroelectric process
®  Fast 2-wire serial interface (12C)
e Upto 1-MHz frequency
e Direct hardware replacement for serial (I2C) EEPROM
e  Supports legacy timings for 100 kHz and 400 kHz
B |Low power consumption
e 100 PA active current at 100 kHz
e 15 pA (typical) standby current
B Wide voltage operation: VDD = 2.7 Vt0 5.5V
B |ndustrial temperature: —40 °C to +85 °C
®  8-pin small outline integrated circuit (SOIC) package
®  Restriction of hazardous substances (RoHS) compliant
Slave Device Address

The first byte that the FM24W256 expects after a START condition is the slave address. As shown in Figure 4-9, the slave
address contains the device type or slave ID, the device select address bits, and a bit that specifies if the transaction is a
read or a write. Bits 7-4 are the device type (slave ID) and should be set to 1010b for the FM24W256. These bits allow
other function types to reside on the 12C bus within an identical address range. Bits 3-1 are the device select address bits.
They must match the corresponding value on the external address pins to select the device. Up to eight FM24W256 devices

can reside on the same I2C bus by assigning a different address to each. Bit 0 is the read/write bit (R/W). R/W = ‘1’ indicates
a read operation and R/W = ‘0’ indicates a write operation.

Figure 4-9. I°C F-RAM Slave Device Address Register

MSB LSB

1| o0 1 1o | A2] A1 | A0 |[RW

\— Slave ID —/\—Device Select—/

Memory Write

All writes begin with a slave address, then a memory address. The bus master indicates a write operation by setting the

LSB of the slave address (R/W bit) to a '0". After addressing, the bus master sends each byte of data to the memory and
the memory generates an acknowledge condition. Any number of sequential bytes may be written. If the end of the address
range is reached internally, the address counter will wrap from 7FFFh to 0000h.
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Single-Byte Write:
Figure 4-10. I°2C F-RAM Single Byte Memory Write

oy e Sto|
2 p
By Master \ Start Address & Data
] v v y v l
1] I T 1 T

S Slave Address 0| A Address MSB A Address LSB A Data Byte A|lP
N Y A I N N A N ) A

By F-RAM % * $ *
—l/ Acknowledge

Multi-Byte Write:

Figure 4-11. I>°C F-RAM Multisystem Memory Write

~ Start

\ Stop
@ \ l Address & Data
. v ' v '
[T T T I I [T FT T 1T T 1 T T I T
S Slave Address 0 A Address MSB A Address LSB A Data Byte A Data Byte AP
|| N | | [ 11 7'y Y | [ [ | I
£ _ 3 d $

By F-RAM
i Acknowledge

Memory Read

There are two basic types of read operations: current address read and selective (random) address read. In a current
address read, the FM24W256 uses the internal address latch to supply the address. In a selective read, the user performs
a procedure to set the address to a specific value.

Current Address and Sequential Read

The FM24W256 uses an internal latch to supply the address for a read operation. A current address read uses the existing
value in the address latch as a starting place for the read operation. The system reads from the address immediately
following that of the last operation.

To perform a current address read, the bus master supplies a slave address with the LSB set to a '1". This indicates that a
read operation is requested. After receiving the complete slave address, the FM24W256 will begin shifting out data from
the current address on the next clock. The current address is the value held in the internal address latch.

Beginning with the current address, the bus master can read any number of bytes. Thus, a sequential read is simply a
current address read with multiple byte transfers. After each byte the internal address counter will be incremented.

Figure 4-12. I°C F-RAM Single Byte Current Address Read

N No
By Master Start Address ACknorIedge
" L\HYH\ T o
S Slave Address 1| A Data Byte 1P
L[] L [ | [ [ | |

By F-RAM \ Acknowledge Data

Figure 4-13. I°C F-RAM Multisystem Sequential Read

) No
By Master \ Start Address Acknowledge Acknowledge
/ i \ | + T \ T T i \ T T T v o
S| SlaveAddress 1A Data Byte A Data Byte 1 p
I | | |

By F-RAM > Acknowledge Data
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Selective (Random) Read

A simple technique allows a user to select a random address location as the starting point for a read operation. This
involves using the first three bytes of a write operation to set the internal address followed by subsequent read operations.

To perform a selective read, the bus master sends out the slave address with the LSB (R/W) set to 0. This specifies a write
operation. According to the write protocol, the bus master then sends the address bytes that are loaded into the internal
address latch. After the FM24W256 acknowledges the address, the bus master issues a START condition. This
simultaneously aborts the write operation and allows the read command to be issued with the slave address LSB set to a
'1'. The operation is now a current address read.

Figure 4-14. F-RAM I?C Selective (Random) Read

", Start

No
By Master | l Address Start Address Acknowledge
= { I l 3 g s
I [ T I [ [ T [ \ I \ I [ I
) Slave Address 0 A Address MSB A Address LSB AlS Slave Address 1| A Data Byte 1P
| |1 [ | [ |1 [ [ | [ | | L] |

ﬁ

By F-RAM
Acknowledge Data

CY15FRAMKIT-001 Serial F-RAM Development Kit Guide, Doc. No. 001-95689 Rev. *C 24



5. Example Projects

&m CYPRESS

- EMBEDDED IN TOMORROW"

Cypress provides four example projects with the CY15FRAMKIT-001 Serial F-RAM DVK package. These example projects
help you to understand the serial F-RAM interface with a microcontroller. The example projects are based on PSoC 4
Pioneer Kit and Arduino UNO R3 Kit.

Download the example projects from www.cypress.com/go/CY15FRAMKIT-001. The installer will place the example
projects under <Install Directory>\CY15FRAMKIT-001 Serial F-RAM Kit\1l.O0\Firmware\ folder

The following example projects are PSoC 4-based and need the PSoC Creator software and the PSoC 4 Pioneer Kit.
®m  PSoC4_FRAM_SPI

®m  PSoC4_FRAM_I2C

The following example projects are Arduino-based and need Arduino IDE and Arduino UNO R3 Kit.

®  Arduino_FRAM_SPI

®  Arduino_FRAM_I2C

5.1 Programming PSoC 4 Pioneer Kit

Follow these steps to program the PSoC 4 example projects (PSoC4_FRAM_SPI project is shown here):

1. Launch PSoC Creator from Start > All Programs > Cypress > PSoC Creator 3.1 > PSoC Creator 3.1. If PSoC
Creator is not installed, download from www.cypress.com/psoccreator.

2. On the Start Page, under Examples and Kits section, choose Kits > CY15FRAMKIT-001. A list of example
projects appears, as shown in Figure 5-1. Click on the desired example project.

Figure 5-1. Opening Example Project from PSoC Creator
Workspace Explorer (0 projects) >3 x /m
&

Mo workspace open

PSoC® Creator™

Design Tutorials -
Getting Started With PSoC 3

Getting Started With PSoC 4

Getting Started With PSoC 5LP

Getting Started with PSoC 4 BLE

Getting Started with PRoC BLE

sjuauodwos | asanos

Examples and Kits
Find Example Project...
= Kis
= CY15FRAMKIT-001 Serial F-RAM Kit
] PSoC4_FRAM_IZC cywrk
E] PSoC4_FRAM_SPlcywrk
I s A

synsay . sjeaLsee

Product Information
PSoC Creator
PSoC Programmer
P5eC 3
PSaC 4
PSoC 5LP
PSoC 4 BLE
PRoC BLE

m

Resources
Cypress Dev Community
Application Notes
PSoCDeveloper.com
Order Samples

Support
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3. Select the folder where you want to save
4.

the project and click OK.

Figure 5-2. Build Project from PSoC Creator

Build the code example by clicking Build > Build <Project name> to generate the hex file.

File Edit View Ern. _Build| Debug. Tools Window Helo
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{h Header Files
EHE} Source Files
EI@ Generated_Source
EHED PSoC4
EH) BLUE_LED
[ e Wi

sjuauadwal

g B

o m

Example Projects

5. Select the operating voltage. CY15FRAMKIT-001 can operate at either 3.3 V or 5.0 V, selected through jumper
J5. The factory default jumper setting is 5.0 V (short pins 1 and 2). Arduino UNO R3 boards operate at 5.0 V and
use the default setting of the jumper J5. The CY8CKIT-042 Pioneer Kit operates at either 3.3 V or 5.0 V. The
default setting of the Pioneer Kit is 3.3 V. Therefore, depending on the voltage setting on the mother board, set
jumper J5 to either 5.0 V (short pins 1 and 2) or 3.3 V (short pins 2 and 3). To program PSoC 4, connect the
Pioneer board to a PC using the USB cable connected to USB Mini-B connector J10 as shown in Figure 5-3.

Figure 5-3. Connect PSoC 4 Pioneer Kit to PC through USB

i Hoscx|(pr
@ @esc|ls

6. Click Debug > Program in PSoC Creator.
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®©

(¢}
RESET | 6ND OG‘
5 Je |
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Figure 5-4. Program Device from PSoC Creator
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7. If the device is not yet acquired, PSoC Creator will open the programming window. Select KitProg and click the

Port Acquire button.
Figure 5-5. Acquire Device from PSoC Creator

Select Debug Target @u

5 KitProg/1222172E03242400 KitProg/1222172E03242400
POWER =3
VOLTAGE_ADC = 3316
FREQUENCY = 2000000
PROTOCOL = SWD

r

KitProg version Expecting 2.00, but
found 1.03

Show all targets v] l Port Setting "

8. After the device is acquired, it is shown in a tree structure below the KitProg. Now, click the Connect button.

Figure 5-6. Connect Device from PSoC Creator

Select Debug Target M
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Silicon ID: 0x0BB11477
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Revision: PRODUCTION

.

Target unacquired

[Shuw all targets A 1@.

(8 -

9. Click OK to exit the window and start programming.
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Figure 5-7. Program Device from PSoC Creator

. — 5
Select Debug Target &‘é
=3 KitProg/1222172E03242400 PSaC 4 CY8C4245AX1-483
L(’ PSoC 4 CY8C4245AX1-483 (Connected) PSoC 4 (ARM CMO0)

Silicon ID: 0x0BB 11477
Cypress ID: 0x04C81193
Revision: PRODUCTION

Target acquired

Show all targets - Disconnect

%
i_J

5.2 UART Setup

This section describes the UART interface setup to display the PSoC 4 example project output on the PC either using
HyperTerminal or PUTTY as an alternative to HyperTerminal for the serial COM connection.

The PSoC 5LP device on PSoC 4 Pioneer Kit can be configured as USB to UART Bridge as shown in Figure 5-8. Both
the PSoC 4 example projects include UART communication to transmit the result to PC via USB port. For more details on
the hardware setup and the architecture, refer to the PSoC 4 Pioneer Kit web page.

Figure 5-8. Block Diagram of UART Connection between PSoC 4 and PSoC 5LP

Jg g9 Jg 10 PO[] PO[5)
P12[6] P12[7] UART RX UART TX
UART RX UART TX
USB D+ P15[6]
" PSoC 5LP PSoC 4
MiniB =p—1°"nm

Connect the RX port of the PSoC 4, accessible through J4_1 (SI) on the CY15FRAMKIT-001 kit to J8 10
(TX). Similarly connect the TX port of PSoC 4, accessible through J4_2 (SO) on the CY15FRAMKIT-001 kit
to J8_9 as shown in Figure 5-9.
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Figure 5-9. UART Connection on PSoC 4 Pioneer Kit

SO |vDD

25cK| S1

Connect USB Mini-B to J10. The kit enumerates as a KitProg USB-UART and is available under the Device Manager >
Ports (COM & LPT). A communication port is assigned to the KitProg USB-UART.

Figure 5-10. KitProg USB-UART in Device Manager

=4 Device Manager

File Action View Help
=@ E]
g ZSK-THINK
> 3 Batteries
b 2| Biometric Devices
;-@ Bluetooth Radios
-8 Computer
1w Disk drives
- Display adapters
- DVD/CD-ROM drives
ﬂfd Hurnan Interface Devices
‘g IDE ATASATAPI controllers
% Imaging devices
-2 Keyboards
-B Mice and other pointing devices
- I Monitors
¥ Network adapters
&F Bluetooth Device (Personal Area Network)
~EF Bluetooth Device (RFCOMM Protocol TDI)
-y, Cisco Systems VPN Adapter for 64-bit Windows
& Intel(R) 82579LM Gigabit Network Connection
- ¥ Intel(R) Centrino(R) Advanced-N 6205
~&F Microsoft Virtual WiFi Miniport Adapter
- & Microsoft Virtual WiFi Miniport Adapter 22
- B Portable Devices
477 Ports (COM & LPT)
= .

| [ B

ATV WY COW W W W W

L ent Technology - 50L (COM3)
"I KitProg USB-UART (COMS)
i ooth link (COMLE)
‘? Standard Serial over Bluetooth link (COM13)
> D Processors

>ﬁ>‘ Security Devices

;-;F SM Driver

»-% Sound, video and game controllers

;-;F System devices

B i Universal Serial Bus controllers

The following sections demonstrate the procedure to setup the serial connection using HyperTerminal or PuTTY on PC
to communicate with the PSoC 4 Pioneer Kit.

5.2.1 HyperTerminal Setup

Open HyperTerminal and select File > New Connection and enter a “Name” for the new connection; click OK.

Figure 5-11. Open New Connection

CY15FRAMKIT-001 Serial F-RAM Development Kit Guide, Doc. No. 001-95689 Rev. *C 29



= CYPRESS

mm> EMBEDDED IN TOMORROW™ Examp|e Projects
B New Connection - HyperTerminal =8 =
File Edit View Call Transfer Help
e 5 0 B3
-
I 5
Connection Description @I&J
New Connection
Enter a name and choose an icon for the connection
| Mamer——
|| FRAM_SPI_Example_Hjper Temminal
lcon
] n +
Disconnected Auto detect  Auto detect

1. A new window opens where the communication port can be selected.

Select the appropriate communication port “COMX” (or the specific communication port that is assigned to
KitProg USB-UART) in Connect using and click OK to go to the next setting for HyperTerminal.

This code example uses COMS. Verify the COM setting for your setup and select the appropriate COMX.

Figure 5-12. Select Communication Port

Connect To @lﬂ_hj

FRAM_SPI_HyperTeminal

Enter details for the phone number that you want to dial:

Country/region: | United States (1)

Area code: 715

Phone number:

Connect using: |COME > -]

[ ok || Cancel |

b

2. The COMX Properties window opens with the Port Settings tab. Click Restore Defaults and then configure
'Bits per second', 'Data bits', 'Parity’, 'Stop bits', and 'Flow control' as shown in Figure 5-13 and click OK. If you
change the PSoC 4 UART port setting in the example project, make sure the same setting is applied on
HyperTerminal. Click OK to start the communication.
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Figure 5-13. Configure Communication Port

? |

COMS Properties

Port Settings

Bits per second: | 9600 -]
Data bits: (8 ~|
Party: | None ~|

Stop bits: [1 ~|

Flow cortrol: | None ~|

Restore Defaults

OK || cancel || ool

HyperTerminal window opens to display the PSoC 4 example projects output.

Figure 5-14. Configure Communication Port

Example Projects

Bx01 0102 0103 Bxb4 B85 Bx06 0x07 6108 Bx09
=0B 0=0C 0=0D 0x0C @x0F 0x10

Status Register Data Write = 0x08
Status Register Data Read = Bx08

Status Register Data Write = 0x00
PSoC4é SPI F-RAM Example Project - PASS

rI FRAM,SPLExample,HyperTermlnalnyperTen'ninaJ_. . s & - e =1L i:h
File Edit View Call Transfer Help -
0O = 3 0yE &
CY15FRAMKIT-B801 Kit - PSoC4 SPI F-RAM Example Project
SPI F-RAM Initialized
Data written to the address 0x2080 = BxAS
Data read from the address 0x2000 = 0xAS
Data written to the address 0x3456 =
0x01 0x02 0x03 0x04 0x05 0x06 007 008 0109 0«0 0
»B@B Bx0C 00D 0x0E Bx0F 0x10
Data read from the address Bx3456 =
Ox0A @

Connected 0:00:30

Auto detect 9600 8-N-1

5.2.2 PUTTY Setup

PUTTY is a free SSH and telnet client for Windows. You can download PuTTY from www.putty.org.

1.

Double-click the putty icon and select Serial under Connection.
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Figure 5-15. Open New Connection

-
% PUTTY Configuration &J
Basic options for your PuTTY session
& T" Specify the destination you want to connect to
3- Te
... Keyboard Host Name (or IP address) Port
- Bell 2
- Features Connection type:
=- Window 1 Raw () Telnet ) Rlogin @ S5H  (7) Serial
Appea@nce Load, save or delete a stored session
- Behaviour
... Translation Saved Sessions
- Selection
-~ Colours Default Settin
gs
[=- Connection Load
- Prowy
Rlogin
@ Close window on exit:
() Mways () Never @ Only on clean exit
About [ Open ] [ Cancel ]

2. A new window opens where the communication port can be selected. Enter the COMX in Serial line to
connect to. This code example uses COMS5. Verify the COM setting for your setup and select the appropriate
COMX.

Select Speed (baud), Data bits, Stop bits, Parity, and Flow control under Configure the serial line. Click
Session and select Serial under Connection type.

Figure 5-16. Select and Configure Communication Port

.
@ PuTTY Configuration ﬂ
Category:
B Session Options controlling local senal lines
i _logging Select a seral line
[=)- Terminal
- Keyboard Serial line to connect to COM5
- Bell ) o
- Features Configure the serial line
=+ Window Speed (baud) 5600
"~ Appoarance Data bits g
- Behaviour
- Translation Stop bits 1
- Selection i
- Colours Rany
[)- Connection Flow control
- Data
- Proogy
- Telnet
- Rlogin
(- S5H
N
| About [ Open ] ’ Cancel ] W

3. Select the Session under Category and set the Communication type: to Serial. Click Open.
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Figure 5-17. Select Communication Type in PuTTY

ﬁ PuTTY Cenfiguraticn

Example Projects

[t

Cateqany:

- Terminal

- Keyboard
- Bell

- Features

= Window

- Appearance
- Behaviour
- Translation
- Selection
- Colours

= Connection

- Diata

- Prosy

- Telnet

- Rlogin
+-S5H

About

Basic options for your PuTTY session

Specify the destination you want to connect to

Serial line Speed

COMS 5600

Connection type:

Raw Telnet Rlogin S5H @ Seral

Load, save or delete a stored session

Saved Sessions

Default Settings | load |
| Save |
| Delete |

Cloze window on exdt:

Always MNewer @ Only an clean exit

[ Cpen l | Cancel

The COM terminal software displays the data from PSoC 4. For example, the initial screen of the SPI example

project is shown in Figure 5-18.

Figure 5-18. Data Displayed on PuTTY

E@ COMS - PuTTY

5PI F-RRM

|,l=l 3 |
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5.3 Project: PSoC 4 F-RAM SPI

5.3.1 Project Description

This example project runs on the CY8CKIT-042 PSoC 4 Pioneer Kit and provides the SPI F-RAM component and APls to
write and read F-RAM memory/status register. The example project will write to F-RAM, read from F-RAM, and indicate
PASS by illuminating the RGB LED (D9) on PSoC 4 in blue. The output is also displayed on HyperTerminal through
UART.

5.3.2 Hardware Connections

Refer to section 5.2 for UART setup. Apart from this, all other connections are hardwired on the board. Open
PSoC4_FRAM_SPIl.cydwr in the Workspace Explorer and select the suitable pin.

Table 5-1. PSoC 4 F-RAM SPI I/O Pin Assignment

F-RAM 1/O PSoC 4 Pin
CSt# P3_4
Sl P30
SO P31
scK PO_6
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Figure 5-19. PSoC 4 F-RAM SPI Example Project Pin Configuration

4
a

-
x

PO | 25 | ==
PO[0]
P43

1| Parn
2 | Pai2)

B
3 Alias ~ Name / Port Pin Lock
: = |
=i D0[4] SCB1:I2C:SCL, SCB1:SPI:MOST e
| § - i
E 2| =\‘3} \URRT:2x\ | SCB1:URRT:RX | 28 S
________ o\ | P0I5] SCB1:I2C:SDA, SCB1:SPI:MISO -
e EiEESENEE \URRT==x\ | scB1 : URRT:TX | 29 Z
BLUE_LED | 2013] v |27 -
cs 3[4] SCB1:SPI:SS1, TCPWMZ:P v|1s -
| somrersso e scx 20[6] SCB1:SPI:SCLK, EXICLK v |30 -
sck 23[0] SCB1:I12C:SCL, SCBL:SBI:MOSI =
r 8z TCPWMO:D, SCBI:UART:RX | [ =
Pois) |29 ] waRT:o0 D3[1] SCB1:I2C:SDA, SCBL:SPI:MISO
TCPWMO-N, SCBL:UART:TX
Poj4) [28 ] WART:o
CY8C4245AXI-483 o 2:7'&“ =
44-TQFP =
P | 25 | smesmiess

acaoarsol|

# pins | W\ Analog | () Clocks | # Interrupts | B% System | (£ Directives | (] Flash Security |

5.3.3 Firmware Flow

Following steps provide the example project firmware flow.

a. Initialize the F-RAM SPI and USB-UART block.

b. Wait for “Enter” key from the display (HyperTerminal / PuTTY)

c. Write EXAMPLE_DATA_BYTE (0xA5) to EXAMPLE_ADDR_1 (0x2000) address.

d. Read a byte from address EXAMPLE_ADDR_1 (0x2000) and store in the fram_rd_byte.

e. Write EXAMPLE_DATA_BYTE (0xA5) to EXAMPLE_ADDR_1 (0x2000) address.

f. Read a byte from address EXAMPLE_ADDR_1 (0x2000) and store in the fram_rd_byte variable.

Write 16 bytes of data from data_bytes array (1, 2, 3, ...,16) to EXAMPLE_ADDR_2 (0x3456) address.
Read 16 bytes of data from EXAMPLE_ADDR_2 (0x3456) address through the read function.

7o«

Write EXAMPLE_STS_REG_VALUE (0x08) to the status register.

j-  Read the status register and store in the 'statug_reg' variable.
k. Compare the read data with the written data. If successful, glow the blue LED.

I.  Clear the status register.

5.3.4 Verify Output

The data output is shown in Figure 5-20 and Figure 5-22.
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Figure 5-20. PSoC 4 F-RAM SPI Example Project Output - Waiting for Enter Key pressed by the User

£P COMS - PuTTY a & ]

Figure 5-21. PSoC 4 F-RAM SPI Example Project Output Data

-
£ COMS - PuTTY Py

5.3.5 Modifying the Project
Open file main.c in the project under Source Files and change the address and data byte values by setting the variables

EXAMPLE_ADDR_1, EXAMPLE_ADDR_2and EXAMPLE_DATA_BYTE shown in Figure 5-22. For example change:
0x2000 to 0x1200, 0x3456 to 0x1600, Oxa5 to Ox5a.
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Figure 5-22. Snapshot of main.c Source File

PSoC4_FRAM_SPLcydwr . main.c

¥include <device.h>
#include <stdio.h>
#include "FRAM SPI.h"

Y]

3

ff 5ize of data buffer
¥define BUFFER SIZE (16u)

oo

$define STRING_SIZE (50u)

/ Emample F-RAM Address
#define EXAMPLE ADDR_1 (0x2000)

o0 Lo 8 R RD ORI Ra R R BRI ORI ORI ORI
o 5 N G =]

'/ Example F-RAM Address

#define EXAMPLE ADDR 2 (0x3456)
f/ Example F-RAM Data

#define EXAMPLE DATA BYTE (Oxas)

Also the user can change the burst write data shown in Figure 5-23. For example, change i+1 to i+3 at line 83 will
initialize the input data from 0x03 — 0x13.

Figure 5-23. Snapshot of main.c source file for initializing input data buffer

S/ Imitialization of wvariables
for(i = 0; i < BUFFER STZE; i++)
{

-]
=]

fram rd data[i] = 0:
data bytes[i] = i+1l;

S U | ST

Build the project with the above changes and program the Pioneer kit. The output will show the data 0x5a written to
address 0x1200 and data 0x03 — 0x13 written from address 0x1600 as shown in Figure 5-24. APIs provided in the next
section can be used to build different applications.

Figure 5-24. Modified SPI F-RAM Project Output

!

&P COMS - PuTTY

5.3.6 APIs

5.3.6.1 void FRAM_SPI_Init(void)

Description: Initializes the SPI block.
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Parameters: None
Return Value: None
Side Effects: None

5.3.6.2 uint8 FRAM_SPI_Write(uint32 addr, uint8 data_write)

Description: Write a single byte of data to F-RAM.
Parameters: uint32 addr: 32 bit F-RAM address for write.
uint8 data_write: data byte to be written.
Return Value: uint8: 0 - Communication Error
1 — Success
Side Effects: None

5.3.6.3 uint8 FRAM_SPI_Read(uint32 addr, uint8 *data_read)

Description: Read a byte of data from F-RAM.
Parameters: uint32 addr : 32 bit F-RAM address for read
uint8 *data_read. : 8 bit pointer variable to hold data
Return Value: uint8: 0 — Communication Error
1 — Success

Side Effects: None

Example Projects

5.3.6.4 uint8 = FRAM_SPI_BurstWrite(uint32  addr, uint8 *data_write_ptr,  uint32

total_data_count)

Description: Write total_data_count number of data into F-RAM.
Parameters: uint32 addr: 32 bit F-RAM address for write.
uint8 *data_write_ptr: Pointer to an array of data bytes to be written.
uint32 total_data_count: Number of data bytes to be written.
Return Value: uint8: 0 — Communication Error
1 — Success
Side Effects: None

5.3.6.5 uint8 = FRAM_SPI_BurstRead(uint32  addr, uint8 *data_read_ptr, uint32

total_data_count)

Description: Read total_data_count number of data from F-RAM.
Parameters: uint32 addr : 32 bit F-RAM address for read.
uint8 *data_read_ptr: Pointer to an array for storing data bytes.
uint32 total_data_count: Number of data bytes to be read.
Return Value: uint8: 0 — Communication Error
1 — Success
Side Effects: None

5.3.6.6 uint8 FRAM_SPI_Status_Reg Write (uint8 data_byte)

Description: F-RAM Status Register Write
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Parameters: uint8 data_byte -> 1 byte status register data to be written

Return Value: uint8: 0 — Communication Error
1 — Success

Side Effects: None

5.3.6.7 uint8 FRAM_SPI_ Status_Reg_Read (uint8 * status)

Description: F-RAM Status Register Read

Parameters: uint8 * status : pointer to hold status register value
Return Value: uint8: 0 — Communication Error
1 — Success

Side Effects: None

5.4 Project: PSoC 4 F-RAM I2C

5.4.1 Project Description

Example Projects

This example project runs on the CY8CKIT-042 PSoC 4 Pioneer Kit and provides the I2C F-RAM component and APIs to
write and read F-RAM memory. The example project will write to F-RAM, read from F-RAM, and indicate PASS by
illuminating the RGB LED (D9) on PSoC 4 in blue. The output is also displayed on HyperTerminal through UART.

5.4.2 Hardware Connections

Refer to section 5.2 for UART setup. Apart from this, all other connections are hardwired on the board. Open

PSoC4_FRAM_I2C.cydwr in the Workspace Explorer and select the suitable pin.

Table 5-2. PSoC 4 F-RAM I2C I/O Pin Assignment

F-RAM I/O PSoC 4 Pin
SDA P4_1
scL P4 0

Figure 5-25.

PSoC 4 F-RAM I?C Example Project Pin Configuration

PSoC4_FRAM_T2C.cyduwr |

-4l

\FRAM_I2C:IZC:scly

SCBO: R

P4[0] SCBO:T2C:SCL,
T-RX

Port

5CB0:SPI:MOST

\FRAM_I2C:IZC:sda\

SCBO: URR

P4[1] SCBO:-T2C:SOA,
T-TX

SCBO-SPI:MISO

BO[4] SCB1:12C:SCL,
SCB1:UART R

SCB1:SPI:MOST

SCBL: UZR!

BO[S] SCB1:I2C:SDA,
T-TX

SCB1:SPI:MISO

p0[3]

AEIEIEE

7} I BN A

< pins [ )\ Anzlog | (&) Clocks Interrupts System

Directives |. (5] Fiash Security |
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5.4.3 Firmware Flow

Following steps provide the example project firmware flow.
a. Init the F-RAM I2C and USB-UART blocks.

b. Write EXAMPLE_DATA_BYTE (0xA5) to EXAMPLE_ADDR_1 (0x2000) address.
c. Read a byte from address EXAMPLE_ADDR_1 (0x2000) and store in the fram_rd_byte variable.
d. Write 16 bytes of data from data_bytes array (1, 2, 3, ...,16) to EXAMPLE_ADDR_2 (0x3456) address.

e. Read 15 bytes of data from EXAMPLE_ADDR_2 (0x3456) address through the random read function.
f. Read the sixteenth byte through the current read function.

g. Compare the read data with the written data and illuminate the blue LED if read is PASS.

5.4.4 Verify Output

The RGB LED illuminates in blue if the read passes. If read fails, the RGB LED will not glow. The data output is shown in

Figure 5-26 and Figure 5-27.
Figure 5-26. PSoC 4 F-RAM I2C Example Project Output - Waiting for Enter Key pressed by the User

'E‘,“- COMS - PuTTY ! — —

Figure 5-27. PSoC 4 F-RAM I2C Example Project Output Data
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5.4.5 Modifying the Project

Open main.c in the project under Source Files and change the values of EXAMPLE_ADDR_1, EXAMPLE_ADDR_2and
EXAMPLE_DATA_BYTE shown in Figure 5-28. For example change 0x2000 to 0x1200, 0x3456 to 0x1600, 0xa5 to
O0x5a

Figure 5-28. Snapshot of main.c source file

PSoC4_FRAM_I2C.cydwr /° main.c

20:| *

Z1iL & HEEEEERR * #
220 #i 1de <device.h>

23] #4i ide <stdio.h>

24! #include "FRAM I2C.h"

25

26 { Size of data buffer

27! #define BUFFER_SIZE (1&u)

28

28 / Bize of string for UART output

3 #define STRING SIZE (50u)

32 f/ Example F-RAM Address

33; #define EXAMPLE ADDR 1 (0x2000)
35 // Example F-R&M Address

36; #define EXAMPLE ADDR 2 (0x3456)
38 f/ Example F-RAM Data

359! #define EXAMPLE DATA BYTE (Oxak)

Also the user can change the burst write data shown in Figure 5-29. For example, change i+1 to i+3 at line 80 will
initialize the input data from 0x03-0x13.

Figure 5-29. Snapshot of main.c source file for initializing input data buffer

S/ Imitialize wariables
78 faor(i = 0; i <« BUFFER S5IZE; i++4)
A=) i _
80 data bytes[i] = i+1;
Bl fram rd data[i] = 0:
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With these changes, build the project and program the kit. Output will show the data 0x5a written to address 0x1200 and
data 0x03 — 0x13 written from address 0x1600 as shown in Figure 5-30. APIs provided in the next section can be used
to build different applications.

Figure 5-30. Modified I1°C F-RAM Project Output

"B coMs - puTTY SRR )

5.4.6 APIs

The following APIs are defined for the PSoC 4 F-RAM I2C. These APIs are the same for Arduino as well.
5.4.6.1 void FRAM_I2C_Init(void)

Description: Initializes the 12C block.
Parameters: None
Return Value: None
Side Effects: None

5.4.6.2 uint32 FRAM_I2C_Write (uint8 slave_id, uint32 addr, uint8 *data_write_ptr, uint32
total_data_count)

Description: Write total_data_count number of data into F-RAM specified by slave_id.
Parameters: uint8 : 7 bit Slave 1D
uint32 addr: 32 bit F-RAM address for write.
uint8 *data_write_ptr: Pointer to an array of data bytes to be written.
uint32 total_data_count: Number of data bytes to be written.
Return Value: For PSoC 4,

uint32 : Error Status

FRAM_I2C_MSTR_NO_ERROR - (0x00u)
FRAM_I2C_MSTR_ERR_ARB_LOST -- (0x01u)

FRAM_I2C_MSTR_ERR LB NAK  -- (0x02u)
FRAM_I2C_MSTR_NOT_READY - (0x04u)
FRAM_I2C_MSTR_BUS_BUSY -- (0x08u)

FRAM_I2C_MSTR_ERR_ABORT_START  -- (0x10u)
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FRAM_[2C_MSTR_ERR_BUS ERR -- (0x100u)
FRAM_[2C_MSTR_ERR -- (OXFFu)

For Arduino UNO,

uint32 : Error Status

Success -- (0x00u)
Data too long to fit in transmit buffer -- (0x01u)
Received NACK on transmit of address  -- (0x02u)
Received NACK on transmit of data -- (Ox03u)
Other error -- (0x04u)
Side Effects: None

5.4.6.3 uint32 FRAM_I2C_Current_Read (uint8 slave_id, uint8 *data_read_ptr, uint32
total_data_count)

Description: Read total_data_count number of data from the current address of the F-RAM
specified by slave_id.

Parameters: uint8 : 7 bit Slave ID
uint8 *data_read_ptr: Pointer to an array for storing data bytes.
uint32 total_data_count: Number of data bytes to be read.

Return Value: For PSoC 4

uint32 : Error Status

FRAM_I2C_MSTR_NO_ERROR -- (0x00u)
FRAM_I2C_MSTR_ERR_ARB_LOST -- (0x01u)
FRAM_[2C_MSTR_ERR_LB_NAK -- (0x02u)
FRAM_[2C_MSTR_NOT_READY -- (0x04u)
FRAM_[2C_MSTR_BUS BUSY -- (0x08u)
FRAM_I2C_MSTR_ERR_ABORT_START -- (0x10u)
FRAM_I2C_MSTR_ERR_BUS_ERR -- (0x100u)
FRAM_I2C_MSTR_ERR -- (OXFFu)
For Arduino UNO, returns the number of bytes read
Side Effects: None

5.4.6.4 uint32 FRAM_ 12C_Random_Read (uint8 slave_id, uint32 addr, uint8 *data_read_ptr,
uint32 total_data_count)

Description: Read total_data_count number of data from F-RAM specified by slave_id.
Parameters: uint8 : 7 bit Slave 1D

uint32 addr: 32 bit F-RAM address for read.

uint8 *data_read_ptr: Pointer to an array for storing data bytes.

uint32 total_data_count: Number of data bytes to be read.
Return Value: For PSoC 4

uint32 : Error Status

FRAM_I2C_MSTR_NO_ERROR -- (0x00u)

CY15FRAMKIT-001 Serial F-RAM Development Kit Guide, Doc. No. 001-95689 Rev. *C 43



= CYPRESS

amp” EMBEDDED IN TOMORROW™ EXample ProjeCtS

FRAM_[2C_MSTR_ERR_ARB_LOST -- (0x01u)

FRAM_I2C_MSTR_ERR_LB_NAK  -- (0x02u)
FRAM_I2C_MSTR_NOT_READY -- (0x04u)
FRAM_I2C_MSTR_BUS_BUSY -- (0x08u)
FRAM_I2C_MSTR_ERR_ABORT_START -- (0x10u)
FRAM_I2C_MSTR_ERR_BUS_ERR -- (0x100u)
FRAM_[2C_MSTR_ERR -- (OXFFu)

For Arduino UNO, returns the number of bytes read

Side Effects: None

5.5 Programming Arduino UNO Kit

Follow these steps to program the Arduino example projects (Arduino_FRAM_SPI project is shown here):

1. Install Arduino IDE. You can download Arduino IDE software from the Arduino webpage:
http://arduino.cc/en/Main/Software.

2. Open the “Arduino_FRAM_SPI“ project folder and double-click the FRAM_SPI_Example.ino file.
Figure 5-31. Arduino Project File Open

= Mame Type

|: ||§l FRAM_SPI Example Arduino file
| CYSPIFRAM H File
|| CYSPIFRAM CPP File

3. Compile the code example by clicking Sketch > Verify / Compile. At the end of successful compiling, the IDE
displays the status “Done compiling.” and generates a binary sketch.

Figure 5-32. Compile the Arduino Project
FRAM_SP1_Example | Arduino 1.0.6 [ ]
File Edit Tools Help

Verify / Compile Ctrl+R

FRAM. Show Sketch Folder  Chrl+K

I Import Library... 2

Add File... B2 Jemiconductor Technoloogy Pwt
SPI F-FAaM Example Project.

-

Thiz file iz free software; you can rediscribute it andsor
it under the terms of either the GNU General Public Licens

LI LT, Y O P I o B
* = # % =

4. To program the Arduino UNO kit, connect the PC to the Arduino board via USB port using an Arduino UNO
compatible USB cable as shown in Figure 5-33. Because Arduino UNO kits operate at 5 V, ensure that the power
select jumper (J5) on the CY15FRAMKIT-001 is placed between pin 1 and pin 2 for 5 V operations.

CY15FRAMKIT-001 Serial F-RAM Development Kit Guide, Doc. No. 001-95689 Rev. *C 44


http://arduino.cc/en/Main/Software

= CYPRESS

g EMBEDDED IN TOMORROW™

Figure 5-33. CY15FRAMKIT-001 mounted on Arduino UNO R3 Kit

5. Load the binary sketch file by clicking the Upload button.
Figure 5-34. Program the Arduino UNO R3 Kit

FRAM_SPI_Example | Arduino 1.0.6
File Edit Sketch Tools Help

Upload

FRAM_SPI_Example
,"l*
* Copyright (o) 2014 by Cypress Semniconductor Technology Pt

* 3PI F-FAM Example Project.
w

R B R A N

5.6 Project: Arduino F-RAM SPI

5.6.1 Project Description

* This file is free software; you can redistribute it and/or
* it under the terms of either the GNU General Public Licens
* or the GNU Lesser General Public License wersion Z.1, both

* rthlished b the Free Snftware Foomdatdiom

; REEIR

AV EEEERR I
ey
! f

5

R

B ligas 17 - T
d 83

X s0/Ypo u D
Ej Rascyf s 0 O
westijevo (O O

[F=% o ==

| »

Example Projects

This example project runs on the Arduino UNO board and provides SPI APIs to write and read F-RAM memory/status
register. The example project will write to F-RAM, read from F-RAM, and display the results in serial output window.

The CY15FRAMKIT-001 Serial F-RAM DVK uses two-byte addressable, 256 Kbit, SPI F-RAM. Two-byte address can
support a maximum of 512 Kbit (64K x 8) density access. To access SPI F-RAMs with a density of 1-Mbit or higher,
three-byte address access needs to be enabled in this example project. Refer to A.7 Enable Three-Byte Address in SPI

F-RAM for details.
5.6.2 Hardware Connections

No additional hardware connection is required for this project because all connections are hardwired on the board. The

Arduino SPI library uses the following pins by default.

Table 5-3. Arduino F-RAM SPI I/0 Pin Assignment

F-RAM I/O Arduino Pin
CS# D10
Sl D11
SO D12
SCK D13
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5.6.3 Firmware Flow

Following steps provide the example project firmware flow.
a. Initialize the F-RAM SPI.

b. Write EXAMPLE_DATA_BYTE (0xA5) to EXAMPLE_ADDR_1 (0x2000) address. Display the written data on serial
output.

c. Read a byte from address EXAMPLE_ADDInitialize the F-RAM SPI.

d. Write EXAMPLE_DATA_BYTE (0xA5) to EXAMPLE_ADDR_1 (0x2000) address. Display the written data on serial
output.

e. Read a byte from address EXAMPLE_ADDR_1 (0x2000) and store in the fram_rd_byte variable. Display the read data
on serial output.

f. Compare the written and read data and display the result (PASS/FAIL) on serial output.
g. Write 16 bytes of data from data_bytes array (1, 2, 3, ...,16) to EXAMPLE_ADDR_2 (0x3456) address.
h. Read 16 bytes of data from EXAMPLE_ADDR_2 (0x3456) address through the read function.

Compare the written and read data and display the result (PASS/FAIL) on serial output.
j. Write EXAMPLE_STS_REG_VALUE (0x08) to the status register.

k. Read the status register and store in the 'statug_reg' variable.

I.  Compare the written and read data and display the result (PASS/FAIL) on serial output.
m. Clear the status register.

Refer to A.7 Enable Three-Byte Address in SPI F-RAM to enable three-byte addressing in the example project.
5.6.4 Verify Output

Open Tools >Serial Port and select the appropriate COM port for communication as shown in Figure 5-35.

Figure 5-35. Serial Port in Arduino IDE

FRAM_SPI_Example | Arduino 1.0.6

File Edit Sketch Help

I |E|
q
o ol

Aute Format Ctrl+T

Archive Sketch
FRAM_SPI_Ex Fix Encoding & Reload
Ly Serial Monitor CtrlsShiftM E
2 * Copyr] por Technoloogy Pwt|
R 30 2 Y N K
4 A% 5

»

5 Iﬁ This § SRR stributd it and/or
& 1t ung tral Public Licens

Programmer 3
7 * or thy wersion Z.1, hoth
& * publif Burn Bootloader L.
a
10

Open Tools > Serial Monitor to view the serial output as shown in Figure 5-36 and Figure 5-37.
Figure 5-36. Serial Monitor in Arduino IDE

FRAM_SP]_Example | Arduino 1.0.6 [=n B <=
File Edit Sketch Help

Auto Format Crl+T
Archive Sketch
FRAM_SFI_Ex; N Sy S

il Serial Monitor Ctrl+ Shift+ M
" Copyrd ior T

effhinology Pwt)

] »

* SR Board ’
%
i »

* This e AR frribute it and/or
* it ung tral Public licens

Programmer 3
* or thy version 2.1, both
+ publif Burn Bootloader L.

i

[SRTR- RN I S SR

-
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Figure 5-37. Serial Monitor Output for SPI F-RAM Project

1. Write Data A5
2. Read Data A5
Write-Read : PASS
3. Write Data Array

5.6.5 APIs

F-BEM SPI Example Project Start

1 2 3 4 5 [ 7 8 9 S B c D E F 10
4, Fead Data Array

1 2 3 4 5 [ 7 8 9 S B c D E F 10
Write-Read : PASS

5. Jtatus Register Write g

6. Jtatus Register Read &
Status Register Write-Read : PRS3
F-RAM SPI Example Project End

5.6.5.1 void FRAM_SPI_lInit()

5.6.5.2

5.6.5.3

5.6.5.4

Description:

Parameters:

Initializes the SPI library

None

Return Value: None

Side Effects:

None

void FRAM_SPI_Write(uint32 addr, uint8 data_write)

Description:

Parameters:

Return Value:
Side Effects:

Write a single byte of data to F-RAM.
uint32 addr: 32 bit F-RAM address for write.
uint8 data_write: data byte to be written.
None

None

uint8 FRAM_SPI_Read(uint32 addr)

Description:
Parameters:
Return Value:

Side Effects:
void

FRAM_SPI_BurstWrite(uint32

Read a byte of data from F-RAM.
uint32 addr : 32 bit F-RAM address for read.
uint8 : data read

None

addr, uint8

total_data_count)

Description:

Parameters:

Return Value:
Side Effects:

Write total_data_count number of data into F-RAM.

uint32 addr: 32 bit F-RAM address for write.

uint8 *data_write_ptr: Pointer to an array of data bytes to be written.
uint32 total_data_count: Number of data bytes to be written.

None

None
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5.6.5.5 void FRAM_SPI_BurstRead(uint32 addr, uint8 *data_read_ptr, uint32
total_data_count)

Description:

Parameters:

Return Value:

Side Effects:

Read total_data_count number of data from F-RAM.

uint32 addr : 32 bit F-RAM address for read.

uint8 *data_read_ptr: Pointer to an array for storing data bytes.
uint32 total_data_count: Number of data bytes to be read.
None

None

5.6.5.6 void FRAM_SPI_ Status_Reg_Write (uint8 data_byte)

Description:
Parameters:
Return Value:

Side Effects:

F-RAM Status Register Write
uint8 data_byte -> 1 byte Status register data to be written
None

None

5.6.5.7 uint8 FRAM_SPI_ Status_Reg_Read (void)

Description:
Parameters:
Return Value:

Side Effects:

F-RAM Status Register Read
None
uint8: 1 byte status register data

None

5.7 Project: Arduino F-RAM I2C

5.7.1 Project Description

This example project runs on Arduino UNO board and provides 12C APIs to write and read from F-RAM memory. The
example project will write to F-RAM, read from F-RAM, and display the results in serial output window.

5.7.2 Hardware Connections

No additional hardware connection is required for this project because all connections are hardwired on the board. The
Arduino WIRE library (I2C) uses the following pins by default.

5.7.3 Firmware Flow

Table 5-4. Arduino F-RAM I2C I/O Pin Assignment

F-RAM I/O Arduino Pin
SDA A4
SCL A5

Following steps provide the example project firmware flow.

a. Initialize F-RAM I2C and provide startup delay.
b. Write EXAMPLE_DATA_BYTE (0xA5) to EXAMPLE_ADDR_1 (0x2000) address.

c. Read a byte from address EXAMPLE_ADDR_1 (0x2000) and store in the fram_rd_byte variable. Display the
read data on serial output.

d. Compare the written and read data and display the result (PASS/FAIL) on serial output.
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h.

Example Projects

Write 16 bytes of data from data_bytes array (1, 2, 3, ...,16) to EXAMPLE_ADDR_2 (0x3456) address.
Read 15 bytes of data from EXAMPLE_ADDR_2 (0x3456) address through the random read function.

Read the sixteenth byte through the current read function.

Compare the written and read data and display the result (PASS/FAIL) on serial output.

5.7.4 Verify Output

Open Tools >Serial Monitor to view serial output as shown in Figure 5-38.

Figure 5-38. Serial Monitor Output for I°C F-RAM Project

COM20

F-RRM I2C Example Project Start

1. Write Data
L5

2. Read Data

No. of bytea Read @ 1
Data : AS

Write-Read : PASS

3. Write Data Array

1 2 3 4 5 [ 7 8 9
4, Bead Data Rrray
1 2 3 4 5 [ 7 8 9

Write-Read : PASS

F-REM I2C Example Project End

5.7.5 APIs

The API description is the same as for the PSoC 4 12C F-RAM. Refer to section 5.4.6
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A.1 CY15FRAMKIT-001 Schematics

........ P
VDD 5V
= R1
c1] 2g VDD
AT~ = OE
3y3 10UF 3 J5 LEDT, |
1 R 220 Ohm
V4 > 1 2N D
3 :23 Power LED Green
3 Pin Header N
SPI F-RAM
VDD
VDD
— : 4 : 4
ng §R15 R4 é
4 7K 4.7k
U1 4.7k c2 c3
CS# 1 8 T~ AT~ i
Cs VDD i
SO R1 30E 27 3 LoD kZ HOLD# 0AUF |1uF :
WP# 3 6 SCK i
) WP SCK4—2 S
VSS Sl F
SPI F-RAM
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AD 1
A1 2
A2

12C F-RAM

Appendix
VDD
>
R7 R8
4.7k 4.7k
u2 . ca cs5
A0 VDD S —_
39 Al WF’"E \éVCPL 4‘61 F /‘?
d u uF
4| A2 SCL{ 5 SpaA
VSS SDA
12C F-RAM

12C F-RAM Device Select Address

A0
A1
A2

By default, A0, Al, A2 are pulled down internally i

W=
w N e

SWi1

NO

3-POS DIP

R1
RA1
R1

P P

VDD
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(J1-J4) Arduino Compatible Headers™ T
HOLD# RS, n AOE b
NO LOAD
a WP# RS, 0E ap
S H:
V3 5V 1 cs# 52
= ] R1 30E a
L= e
g 4 SCK R‘I,(/\/\SOE g .
RESET 6 g 5 ;
! SDA__ RIQ A A30E )
I~ 9
8 ls V4 SCL__ R2Q’AUA30E 109
BrIRECE 10x1 RECP
J2 s R 20E Ja
NO LOAD 1 1
] 2
21, SO R A A30E] 32
SDA _Rg 30E 2 3 NO LOAD g M
I :
R10 ~ 30E[ |6 :
e WP RUAAE 8 1g
o 6x1 RECP NO LOAD —
Debug Header
J6 VDD NO LOAD NO LOAD
TP1 TP2 NO LORD VDD
— 1y 22 c6 BLAC BLAC P3
RES : — Py BLA
RESET 5|2 4[® g
> © 0.1 uF
3X2 CONN FEMALE
NO LOAD 7
J7
SbA 1 i, 5|2 SCL
CS# 3 4 —
=3 4
2X2 CONN FEMALE
NO LOAD
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A.2 Pin Assignment Table

This section provides the pin map of the headers and their usage.

Arduino Compatible Headers (J1, J2, J3, J4)

Appendix

J1
Pin Arduino Signal PSoC 4 Pioneer Kit Signals CY15FRSAi3/InI;II'2-001 A
Ji 1 VIN VIN NC
J1 2 GND GND GND
J1 3 GND GND GND
Ji_4 5V V5.0 5V
J1.5 3.3V V3.3 3Vv3
J1 6 RESET# RESET# RESET#
J1.7 IOREF P4_VDD NC
J1.8 NC NC NC
J2
Pin Arduino Signals PSoC 4 Pioneer Kit Signals CYlSFRSAi‘gAngIZ_OOl il
J2. 1 AO P2[0] NC
J2.2 Al P2[1] NC
J2_3 A2 P2[2] NC
J2 4 A3 P2[3] NC
J2.5 A4 /SDA (I2C) P2[4] SDA
J2_6 A5/SCL (I?C) P2[5] SCL
J3
Pin Arduino Signals PSoC 4 Pioneer Kit Signals CY15FRAMKIT-001 Kit Signals
J3 1 D8 P2[6] HOLD# (SPI F-RAM)
J3 2 D9 (PWM) P3[6] WP# (SPI F-RAM)
J3_3 D10 (PWM/SS) P3[4] / CS (SCB1) CS# (SPI F-RAM)
J3 4 D11 (PWM /MOSI) |P3[0]/ MOSI (SCB1) Sl
J3 5 D12 (MISO) P3[1] / MISO (SCB1) SO
J3 6 D13 (SCK) PO[6] / SCK (SCB1) SCK
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J3
Pin Arduino Signals PSoC 4 Pioneer Kit Signals CY15FRAMKIT-001 Kit Signals
J3_7 GND GND GND
J3._8 AREF P1[7] NC
J3 9 SDA P4[1] / SDA (SCBO0) SDA
J3_10 SCL P4[0] / SCL (SCBO0) SCL
J4
Pin Arduino Signals PSoC 4 Pioneer Kit Signals CYlSFRQg/InI;II'IS'-OM B
J4a 1 DO (UART RX) PO[4] / SCL (SCB1) NC
J4a 2 D1 (UART TX) PO[5] / SDA (SCB1) NC
J4a 3 D2 PO[7] NC
J4a 4 D3 (PWM) P3[7] NC
J4a_5 D4 PO[0] NC
J4 6 D5 (PWM) P3[5] NC
Ja 7 D6 (PWM) P1[0] NC
J4 8 D7 P2[7] WP (12C F-RAM)

A.3 Debug Header 1/0s

J6
Pin Debug Signals
J6_1 SO
J6_2 VDD
J6_3 SCK
J6_4 Sl
J6_5 RESET#
J6_6 GND

J7
Pin Debug Signals
J7.1 SDA
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Pin Debug Signals
J7.2 scL
J7.3 cs#
J7 4 GND

A.4 Use of Zero-ohm Resistors and No Load

Unit Resistor Usage
SPI E-RAM Device RS Solder zero-ohm resistor to control the SPI HOLD# pin
from the controller
SPI E-RAM Device R6 Solder zero-ohm resistor to control the SPI WP# pin from
the controller
i . 5 .
2C E-RAM Device R11 Solder zero-ohm resistor to control the 1“°C WP pin from

the controller

A.5 Use of 30-ohm Resistors and No Load

Unit Resistor Usage

12C Communication R9 Solder a 30-ohm resistor to access the SDA for the 12C
communication in Arduino UNO R2 boards

12C Communication R10 Solder a 30-ohm resistor to access the SCL for the I12C
communication in Arduino UNO R2 boards
Solder a 30-ohm resistor to use J4_1 as SPI Sl pin. This

SPI Communication R21 will free the Sl on J3_4, which can be used for the
I2C-USB Bridge communication on the CY8CKIT-042
Pioneer Kit.
Solder a 30-ohm resistor to use J4_2 as SPI SO pin. This

L will free the SO on J3_5, which can be used for the
SPI Communication R22

I2C-USB Bridge communication on the CY8CKIT-042
Pioneer Kit.
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A.6 Bill of Materials (BOM)

Appendix

No. | Qty Reference Value Description Manufacturer Mfr Part Number
PCB, 52.07mm X
53.59mm, 2 Layer,
Enig Finish, High Tg,
1 Blue color Solder Cypress
mask, white color
silkscreen
CAP TANT 10UF 10V .
2 1 C1l 10 uF 20% 1206 AVX Corporation (1)'PSA106M010R180
CAP CER 0.1UF 50V Murata GRM188R71C104K
3 3 €2,C4,C6 0.1 uF Y5V 0603 Electronics A01D
CAP CERAMIC 1.0UF .
4 2 C3,C5 1uF 25V X5R 0603 10% Taiyo Yuden TMK107BJ105KA-T
CONN RCPT .100"
5 2 J1,J4 8x1 RECP 8PS R/A SGL TIN Samtec Inc SSQ-108-03-T-S
CONN RCPT .100"
6 1 J2 6x1 RECP 6POS SNGL TIN Samtec Inc SSQ-106-03-T-S
CONN RCPT .100"
7 1 J3 10x1 RECP 10POS SNGL TIN Samtec Inc SSQ-110-03-T-S
3 Pin CONN HEADER
8 1 J5 VERT SGL 3POS 3M 961103-6404-AR
Header
GOLD
Power LED LED GREEN CLEAR Chicago
9 1 LED1 Green 0805 SMD Miniature CMD17-21VGC/TRS
RES 0.0 OHM 1/8W .
10 1 R1 OE JUMP 0805 SMD Panasonic - ECG | ERJ-6GEYOR0O0OV
RES 220 OHM 1/10W .
11 1 R2 220 Ohm 5% 0603 SMD Panasonic-ECG ERJ-3GEYJ221V
R3,R4,R7,R8,R1 RES 4.7K OHM 1/10W .
12 8 2 R13.R14, R15 4.7k 5% 0603 SMD Panasonic-ECG ERJ-3GEYJ472V
R16,R17,R18,R1 RES SMD 30 OHM 5% .
13 5 9.R20 30 ohm 1/10W 0603 Panasonic - ECG | ERJ-3GEYJ300V
SW DIP SLIDE SPST .
14 1 SW1 3-POS DIP 3 POS UNSEALD E-Switch KAS1103E
TVS DIODE 5VWM Diodes
1511 TVS1 5V 350W 14.5VC SOD323 Incorporated SD05-7
IC FRAM 256-KBIT
16 1 Ul SPI F-RAM 40MHZ 8SOIC Cypress FM25W256-G
IC FRAM 256-KBIT
17 1 u2 12C F-RAM 3.4MHZ 8S0IC Cypress FM24W256-G
18 1 N/A Jumper Jumper 3M 969102-0000-DA
No Load Components
CONN HEADER
19 1 J6 3X2 CONN VERT DUAL 6POS 3M 961206-6404-AR
FEMALE
GOLD
CONN HEADER
20 1 J7 2X2 CONN VERT DUAL 4POS 3M 961204-6404-AR
FEMALE
GOLD
RES 0.0 OHM 1/10W .
21 3 R5,R6,R11 OE 0603 SMD Panasonic - ECG | ERJ-3GEYJ302V
RES SMD 30 OHM 5% .
22 4 R9,R10,R21,R22 | 30E 1/10W 0603 Panasonic - ECG | ERJ-3GEYJ300V
TEST POINT PC MINI | Keystone
23 3 TP1,TP2,TP3 BLACK .040"D Black Electronics 5001
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Appendix

No. ‘ Qty | Reference Value Description Manufacturer Mfr Part Number
Special Jumper Installation Instructions
_Install Headers & Wire
24 |1 J5 jumper Housings 2.54MM 3M 969102-0000-DA
across pins
SHUNT
land?2
Label
LBL, PCA Label,
Vendor Code,
Datecode, Serial Cypress
25 L N/A N/A Number 121-60201-01 | Semiconductor
REV 01
(YYWWVVXXXXX)
LBL, CY15FRAMKIT- c
26 |1 N/A N/A 001 QR Code, 12mm ypress
Semiconductor
X 12mm
LBL, Anti-Static
Warning, ULINE PN S- Cypress
27 1 N/A N/A 6516, 5/8" x 2", Semiconductor
"Attention Observe
Precautions"
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A.7 Enable Three-Byte Address in SPI F-RAM
This section describes how to configure the FRAM_SPI example project to access three-byte address SPI
F-RAMs (1-Mbit and higher density parts).
1) Open the CYSPIFRAM.h file in the “Arduino_FRAM_SPI" project folder.

2) Set THREEBYTEADDRESS to ‘1’ as shown below. This enables the third address byte transmitted
over the SPI line to access three-byte addressable SPI F-RAMs.

#define THREEBYTEADDRESS 1

#define THEREEBYTEADDRESS 0O f/Disable 3-byte address access in SPI F-RRMs
f/#define THREEBYTEADDEESS 1 //Enabkle 3-byte address in 1Mk and above densities| SFI F-EAMs
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